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Concurrent Engineering
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Things started to speed-up
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Winner, Robert I., Pennell, James P., Bertrand, Harold E., and Slusarczuk, Marko M. G. (1991). 

"The Role of Concurrent Engineering in Weapons System Acquisition", Institute for Defense
Analyses Report R-338, December 1988, p v.

https://apps.dtic.mil/dtic/tr/fulltext/u2/a203615.pdf


Parallelization/INTEGRATION of work
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Concurrent engineering: an overview for Autotestcon | IEEE Conference Publication | 
IEEE Xplore

The Role of Reduced Latency in Integrated Concurrent Engineering | Center for 
Integrated Facility Engineering (stanford.edu)

https://ieeexplore.ieee.org/document/81104
https://ieeexplore.ieee.org/document/81104
https://cife.stanford.edu/role-reduced-latency-integrated-concurrent-engineering
https://cife.stanford.edu/role-reduced-latency-integrated-concurrent-engineering


2001 – Agile manifesto

• We follow these principles:
• Our highest priority is to satisfy the customer through early and 

continuous delivery of valuable software.

• Welcome changing requirements, even late in development. Agile 
processes harness change for the customer's competitive advantage.

• Deliver working software frequently, from a couple of weeks to a 
couple of months, with a preference to the shorter timescale.

• Businesspeople and developers must work together daily throughout 
the project.

• Build projects around motivated individuals. Give them the 
environment and support they need and trust them to get the job 
done.

• The most efficient and effective method of conveying information to 
and within a development team is face-to-face conversation.

• Working software is the primary measure of progress.

• Agile processes promote sustainable development. The sponsors, 
developers, and users should be able to maintain a constant pace 
indefinitely.

• Continuous attention to technical excellence and good design 
enhances agility.

• Simplicity--the art of maximizing the amount of work not done--is 
essential.

• The best architectures, requirements, and designs emerge from self-
organizing teams.

• At regular intervals, the team reflects on how to become more 
effective, then tunes and adjusts its behavior accordingly.
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Manifesto for Agile Software Development (agilemanifesto.org)

https://agilemanifesto.org/
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Modern concurrent engineering



16 Bidirectional Graphical Modelling Supporting Concurrent Spacecraft Design | Semantic Scholar

https://www.semanticscholar.org/paper/Bidirectional-Graphical-Modelling-Supporting-Design-Schaus-M%C3%BCller/2e0d9124ebd9ee4a38260756ac1850093dd4737d


17 (PDF) Concurrent Engineering Knowledge Management Architecture (researchgate.net)

https://www.researchgate.net/publication/225024184_Concurrent_Engineering_Knowledge_Management_Architecture


ESA - What is the CDF?

https://www.esa.int/Enabling_Support/Space_Engineering_Technology/CDF/What_is_the_CDF
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Multiple spreadsheet through a shared bd



(joke) motto
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From doc to model



•Collaborative work (SystemToSubsystem / T4C)

•Data-base of solutions (reuse) (Libraries)

• Strong Interface Definition/Management

•Optimization (man-made / automatic)

•Coupled analysis – Simulation (P4C and other connectors)

•Model has SEVERAL THOUSANDS of advantages, however
the spreadsheet metaphor is easy and known.

Challenges – co-engineering
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PHYSICAL ARCHITECTURE
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WHAT IS IN THE PHYSICAL 
ARCHITECTURE (PA)?
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Physical Architecture

“how the system will be built”

• This perspective has the same objective as the logical architecture, 
except that it defines the finalized architecture of the system, as it 
should be completed and integrated.  It adds the functions 
required by the implementation and technical choices and reveals 
the behavioral components that perform these functions. These 
behavioral components are then implemented using host 
implementation components that offer them the necessary 
material resource. 

• Defines the solution at a sufficient level of detail to specify the
developments and acquisitions of all subsystems (or components)
to be implemented, and to define and orientate the system 
integration, verification and validation (IVV) phases.

26



• It is often at this level only that choices and constraints 
are introduced related to implementation and production 
technologies, to existing elements to be re-used. 

•Any ambiguities or inaccuracies that could still exist in the 
logical architecture (LA), if they did not impact its 
structuring, should this time be resolved, in order to 
constitute clear development contracts for the identified 
components.

•PA is the privileged place of co-engineering with 
subsystem engineering and software or hardware 
components.
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• to define the structuring principles of the architecture and 
behavior;

• to detail and finalize the expected system behavior;

• to build and rationalize one or more possible system 
architectures;

• to select, complete and justify the system architecture 
retained.

28

The main activities to be undertaken for the 
definition of the finalized PA



Definition of the structuring principles of the 
architecture and behavior

• The major objective of the PA is to minimize complexity 
through rationalizing.
• One of the most used means of rationalization consists of 

reducing diversity and heterogeneity within the solution, by 
searching for similarities and therefore possible architecture 
invariants (sometimes called “patterns”) that can be applied 
more than once in the same manner – or configurable.

• Another classic way to overcome complexity is based on the 
separation of concerns and their containment within parts of 
the architecture as separate as possible from each other.
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Detail and finalization of the expected system 
behavior

•Define the expected behavior of the system, to a level of 
detail and validation enough so that each of its 
components can be implemented (or selected and 
purchased), without any further risk or major questioning; 
this definition must of course demonstrate compliance 
with constraints, especially nonfunctional constraints, by 
which the system will have to abide when being used 
under operational conditions.
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• In particular, the finalized behavior should not necessarily 
be considered as a simple refinement of that defined in 
the LA. The finalization of the chosen behavior in fact 
often constitutes a re-designing, which must result from 
the comparison between the principle behavior of the LA, 
and the implications of the principles chosen in the PA: 
technological choices and adoption of standards, 
previous structuring principles, etc.
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Construction and rationalization of one or more 
possible system architectures
• This step is intended to define one or more solutions reflecting the 

structuring principles defined in the LA, the previous finalized 
behavior, satisfying the expected non-functional constraints and 
applying technology and reuse choices decided in accordance with 
the structuring principles adopted.
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• In the simplest cases, or in systems with 
a physical or electrical dominant, the 
exchange items are often simple in their 
description and usage at this 
engineering and modeling level. 
However, for more complex exchange 
items, involving large numbers of 
exchange contents elements, it is 
desirable to be able to structure a list of 
exchange items that can be extensive, 
by grouping them by type of service 
achieved, for example. This is the role of 
the concept of an interface (also mainly 
present in software design).
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• The PA complements this behavioral description by 
way of the definition of implementation 
components, or hosting physical components, 
containing behavioral components and forming the 
infrastructure of the system; the behavioral 
components are deployed on these host 
components, which provide necessary resources for 
their behavior and hardware vectors (links) for their 
communications. It may thus consist of high-
performance computers, resources for digital or 
analog processing, mechanical systems, 
evaporators, furnaces, chemical reactors, etc.

• Hosting physical components are themselves 
connected by physical links, reflecting the media 
that channel exchanges between behavioral 
components (a cabled network, a satellite link, a 
pipe or a mechanical shaft, for example).

• The same rationalization processes have to be 
performed for hosting physical components as for 
the behavior and behavioral components, in 
compliance with the established structuring 
principles.

34



Selection, completion and justification of the 
system architecture 
• Finalize the choices among potential alternatives, and verify 

that the retained alternative satisfies, possibly by means of 
an acceptable trade-off, all of the needs and constraints that 
have been imposed thereon.

• For example, the implementation resources available may not 
be sufficient to support an expected behavior or associated 
properties (computational load too high for a given process in 
computers supporting it, temperature and pressure too high 
for a given pipe, etc.). This will lead to a redesigning of the 
architecture, including a redecomposition and a different  
distribution of behavioral components, or the use of other 
implementation resources (more powerful computers, more 
robust pipes).
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define the structuring 
principles of the 
architecture and 
behavior;

Factors impacting or constraining the definition of the architecture, as well as 
the viewpoints and structuring design choices mentioned earlier, equally apply 
to this level of architecture and are to be taken into account in a similar way.

detail and finalize the 
expected system 
behavior;

define the expected behavior of the system, to a level of detail and validation 
enough so that each of its components can be implemented (or selected and 
purchased), without any further risk or major questioning

build and rationalize 
one or more possible 
system architectures

define one or more solutions reflecting the structuring principles defined in the 
LA, the previous finalized behavior, satisfying the expected non-functional 
constraints and applying technology and reuse choices decided in accordance 
with the structuring principles adopted.

select, complete and 
justify the system 
architecture retained.

finalize the choices among potential alternatives, and verify that the retained 
alternative satisfies, possibly by means of an acceptable trade-off, all of the 
needs and constraints that have been imposed thereon.
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SUMMARY
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https://www.slideshare.net/HelderCastro3/mbse-with-arcadia-methodpdf-25666409641

https://www.slideshare.net/HelderCastro3/mbse-with-arcadia-methodpdf-256664096


https://www.slideshare.net/HelderCastro3/mbse-with-arcadia-methodpdf-25666409642

https://www.slideshare.net/HelderCastro3/mbse-with-arcadia-methodpdf-256664096


https://www.slideshare.net/HelderCastro3/mbse-with-arcadia-methodpdf-25666409643

https://www.slideshare.net/HelderCastro3/mbse-with-arcadia-methodpdf-256664096


PHYSICAL ARCHITECTURE 
CONCEPTS
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•At this level, the main concepts proposed by Arcadia are 
similar to those of the Logical Architecture: Physical 
Function, Functional Exchange, Physical Component, 
Physical Actor, etc. However, there are some additional 
concepts, notably:
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•Behavior Physical Component: Physical Component 
tasked with Physical Functions and therefore carrying out 
part of the behavior of the System (for example software 
component, data server, etc.);
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•Node (or Implementation) Physical Component: Physical 
Component that provides the material resources needed 
for one or several Behavior Components (for example 
processor, router, OS, etc.).
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•Physical Port: non-oriented port that belongs to an 
Implementation Component (or Node). The structural 
port (Component Port), on the other hand, has to belong 
to a Behavior Component;
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•Physical Link: non-oriented material connection between 
Implementation Components (or Nodes). The 
Component Exchange remains a connection between 
Behavior Components. A Physical Link allows one or 
several Component Exchanges to take place (for example
Ethernet cable, USB cable, etc.);
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•Physical Path: organized succession of Physical Links 
enabling a Component Exchange to go through several 
Implementation Components (or Nodes).
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PHYSICAL ARCHITECTURE 
DIAGRAMS
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Initialization and automated update of the physical functions 
according to the logical functions

The transition tools create a first 1-1 traceability mapping between 
Physical Architecture and Logical Architecture. Use dedicated 
traceability matrices to modify the traceability relationships.

Enrich and details the functional breakdown with new physical 
functions.

Describe the data flows between physical functions and identify 
specific functional chains.

The initialization and automated updated of the physical actors can be 
automatically performed according to logical actors.

Define the physical components. A physical component is a physical 
representation of an entity in the system (hardware, software, 
firmware, personnel, facilities, data, materials, services and 
processes). It is in charge of the implementation of one or several 
logical components. A physical component can be Node or Behavior.
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The behavioral physical components are responsible for implementing 
the physical functions. Manage these allocations using an architecture 
diagram and deduce component exchanges implementing the 
functional exchanges.

Manage the deployment of behavior components on node 
components and deduce physical links and paths. Create dataflows 
scenarios to illustrate functional exchanges between the components.

Delegate each logical interface to one physical component. Create new 
physical interfaces between components.

Specify the dynamical behavior of the physical components by 
completing the interaction sequences coming from the Logical 
Architecture. The enrichment of the interaction sequences and the 
identification of the new physical interfaces are two very tight and 
iterative activities.

The scenario refinement process is iterative, each update on a source 
can be automatically propagated to the target.
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Final Considerations



SOME THOUGHTS

•Physical architecture answers:
• “how the system will be built”

• In the physical architecture the system choices are 
concretized.

• Focus on technological trades that implements the 
functions

• Focus in the realize the “to-be”

•Maps the technologies into the designed functions.
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• Fazer a etapa da formalização do sistema construído

• Apresentar como o sistema logístico vai ser construído.

• Apresentar o modelo da arquitetura final:
• Características mínimas: realizar 2 nós com 1 comportamento em cada

(mínimo). Anexar os comportamentos vindos da LA. Indicar como o
sistema foi “totalmente construído / entregue pelo fabricante”.

• Extra-fun: Gerar um doc com no mínimo uma arquitetura de cada
camada (AO-PA), trazer o título do diagrama e o diagrama
automaticamente.

Atividades para a próxima aula
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Document Generation
https://www.m2doc.org/
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• O projeto M2Doc fornece a geração de documentos do Word 
(arquivos .docx) com base em um modelo de documento e 
modelos EMF.

• A abordagem geral consiste na criação de modelos no formato 
OOXML em que a criação de texto estático se beneficia dos 
recursos WYSIWYG do Microsoft Word. Partes dinâmicas são 
inseridas usando um vocabulário dedicado de código de 
campos OOXML. 

• Os campos são usados principalmente para inserir números de 
página, referências, etc. O M2Doc faz uso de diretivas de 
geração de documentação. Isso permite uma separação total 
entre o documento e as diretivas M2Doc.
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conceitos
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•A linguagem de modelo faz um uso extensivo da Acceleo
Query Language, que fornece uma linguagem de consulta 
de modelo. 

•Os modelos M2Doc podem ser validados. Se forem
encontrados erros, um modelo anotado será produzido
descrevendo os problemas encontrados.

63

Princípios



•Definição dos pontos de entrada do modelo.

• Extração de informações navegando no modelo.
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Princípios
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• Template user: que já possuem o modelo e desejam gerar o 
documento. 
• Edita modelos e quer produzir documentos

• Template developer: que querem criar seu próprio modelo
• Templates podem ser usados em diferentes documentos.
• Varios templates podem ser usados em um modelo.
• Conhece a estrutura de navegação AQL

• Integrator (Meta-model Expert): que desejam fornecer 
geração de documentos em seu próprio projeto usando 
M2Doc.
• Cria serviços AQL para criadores de templates.

66

Não é fácil e necessita de pessoas específicas:



Básico de metamodelagem
https://www.eclipse.org/modeling/emf/
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• EMF : Eclipse Modeling Framework
• Modelagem de dados Java e framework de integração 

• Fornece a infraestrutura para realmente usar os modelos em 
um aplicativo 

• Facilmente acessível 

• Open source – EPL licence 
• Necessário conhecimento em Java 
• Aliás também em UML, XML Schema

• Baseado em modelagem > geração de código 

• Possibilita a produção rápida de modeladores

• Utiliza toda a facilidade trazida pelo Eclipse68

Metamodelagem



•Um modelo EMF é um conjunto de dados 
• Conformação a um metamodelo
• Composto por objetos com propriedades e relações 

• Serializado em um arquivo XMI 

•Conceitos próximos aos do diagrama de classes UML 
• Elements ~ Class
• Attributes
• References ~ Associations

69

Meta modelo



• Um link entre o mundo do desenvolvimento e o mundo da 
modelagem 
• Converte modelos em código e vice-versa 
• Fornece toda a infraestrutura necessária de M / MM / M2M

• Gratuito 
• Licença EPL
• Poucos pré-requisitos
• Pode operar no modo autônomo (sem acesso externo)

• Estabilidade 
• Desenvolvido desde 2002
• No centro da infraestrutura do Eclipse 

70

Benefícios



71
https://download.eclipse.org/modeling/emf/emf/javadoc/2.9.0/org/eclipse/emf/ecore/pa
ckage-summary.html

https://download.eclipse.org/modeling/emf/emf/javadoc/2.9.0/org/eclipse/emf/ecore/package-summary.html
https://download.eclipse.org/modeling/emf/emf/javadoc/2.9.0/org/eclipse/emf/ecore/package-summary.html


72 https://eclipsesource.com/blogs/tutorials/emf-tutorial/

https://eclipsesource.com/blogs/tutorials/emf-tutorial/


Acceleo Query Language
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•A Acceleo Query Language (AQL) é uma 
linguagem usada para navegar e consultar um 
modelo EMF.

•O AQL como mecanismo de consulta é pequeno, 
simples, rápido, extensível e traz uma validação 
mais rica do que o interpretador MTL (Model to Text 
Language)

•O interpretador AQL é usado no Sirius com o prefixo 
«aql:»

74

introdução



• From a variable one can access field or 
reference values using the . separator.

• With self being an instance 
of Person, self.name returns the value of the 
attribute name and self.father return the father 
of the person.

• If the attribute or the reference is multi-valued, 
then self.parents will return a collection.

• Calls can be chained, as 
such self.parents.name will return a collection 
containing the names of the parents.

• If one want to access the collection itself, then 
the separator -> must be used, as 
such self.parents.name->size() will return the 
number of elements in the collection 
whereas self.parents.name.size() will return a 
collection containing
the sizes of each name.
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•A noção de contexto 
• Uma consulta AQL se aplica ao seu contexto (denotado por 

“self”) 

•A navegação está em conformidade com o metamodelo
usando a notação de pontos 
• Acesso a referências e atributos 
• Exemplo : aql:self.ownedSchemas.name
• No contexto de um Banco de Dados, recupere os nomes dos 

esquemas de propriedade do banco de dados atual. 

76

Sintaxe



• Outros exemplos de consulta 
• aql:self.name in a Table context → Name of the Table 

• aql:self.ownedTableElements.name in the context of 

Table → Column names list 

• aql:self.ownedTableElements→size() in the context of a 

Table → Number of columns of the Table 

• Elementos estáticos vs elementos dinâmicos 
• aql:'Table_ ' + self.name in the context of a Table named 

'Vehicle' → “Table_Vehicle” 

• aql:’Prefixe' + self.name + ‘Sufixe' → 
“PrefixeVehicleSufixe” 

77

Sintaxe



•Disponível em Window > Show View > Interpreter

• Trabalha com representações do Sirius

•Mas também em todos os modelos EMF 

•Muito útil para ajustar consultas 

78

Estruturando as buscas: interpreter



https://www.eclipse.org/acceleo/documentation/

https://www.eclipse.org/acceleo/documentation/


(super) Pequeno exemplo...
https://www.m2doc.org/

80



•Primeiro você precisa baixar Capella. 

•Quando o download estiver concluído, extraia o arquivo 
baixado e execute o executável Eclipse na subpasta 
Eclipse. 

• INSTALLATION FOR CAPELLA 6.1.X
• https://s3-eu-west-1.amazonaws.com/obeo-

networkaggregation-releases/capella-
extensions/6.1.0_M2Doc3.3.0/full zip (M2Doc 3.3.0)

81

Instalação 

https://s3-eu-west-1.amazonaws.com/obeo-networkaggregation-releases/capella-extensions/6.1.0_M2Doc3.3.0/full/org.obeonetwork.capella.update.full.zip


instalando O M2DOC

82



Abrindo o exemplo

83

Arquivos que são gerados

Templates de textos
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Alt+f9

ctrl+f9
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